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Chapter 406

Confidence Intervals
for the Exponential
Lifetime Mean
Introduction
This routine calculates the number of events needed to obtain a specified width of a confidence interval for the
mean of an exponential distribution at a given level of confidence. The calculations assume Type-II censoring,
that is, the experiment is run until a set number of events occur.

Technical Details
This procedure is based on the results of Mathews (2010) and Lawless (2003). The exponential lifetime model
is based on the exponential density function
1
exp(−𝑡/𝜃), 𝑡 ≥ 0
𝜃
where 𝜃 is the mean lifetime, mean failure time, mean time to failure, or mean time between failures. This model
is also parameterized in terms of failure rate, λ which is equal to 1/θ. In this case, the density is
𝑓(𝑡) =

The cumulative exponential distribution is

𝑓(𝑡) = 𝜆exp(−𝜆𝑡), 𝑡 ≥ 0.

𝐹(𝑡) = 1 − exp(−𝑡/𝜃), 𝑡 ≥ 0.

The survival or reliability function is

𝑅(𝑡) = 1 − 𝐹(𝑡)

which in the case of the exponential distribution results in

𝑅(𝑡) = exp(−𝑡/𝜃)

With the assumption of Type II censoring, the maximum-likelihood estimate of 𝜃 based on observing E failures in
N items tested is
𝑁

th

1
𝑡̅ = � t 𝑘
𝐸
𝑘=1

where tk is the amount of time that the k item was under test, whether the event of interest was observed in that
item or not.
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An exact 100(1 – α) % confidence interval for 𝜃 is given by
𝑃�

2𝐸𝑡̅

2
𝜒1−𝛼/2

≤𝜃≤

2𝐸𝑡̅
2 �=1−𝛼
𝜒𝛼/2

where χ2𝜑 is the value of the chi-square random variate with 2E degrees of freedom that has probability φ to the
left.
One-sided limits may be obtained by replacing α/2 by α.

Confidence Interval Width
The confidence interval width, confidence level, and number of events are related in the equation
𝑊𝑖𝑑𝑡ℎ = 𝑈𝐶𝐿 − 𝐿𝐶𝐿

where LCL and UCL are the lower and upper confidence limits.
This equation can be used to find E, α, or the width.

Confidence Level
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are drawn from a
population using simple random sampling and a confidence interval is calculated for each sample, the proportion of
those intervals that will include the true population parameter is 1 – α.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
This option specifies the parameter to be solved for from the other parameters.

One-Sided or Two-Sided Interval
Interval Type
Specify whether the confidence interval for the population correlation is two-sided or one-sided. A one-sided
interval is often called a confidence bound rather than a confidence interval because it only has one limit.
Two-Sided
The two-sided confidence interval is defined by two limits: an upper confidence limit (UCL) and a lower
confidence limit (LCL).
These limits are constructed so that the designated proportion (confidence level) of such intervals will include the
true population value.
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Upper One-Sided
The upper confidence interval (or bound) is defined by a limit above the estimated parameter value. The limit is
constructed so that the designated proportion (confidence level) of such limits has the true population value below
it.
Lower One-Sided
The lower confidence interval (or bound) is defined by a limit below the estimated parameter value. The limit is
constructed so that the designated proportion (confidence level) of such limits has the true population value above
it.

Confidence
Confidence Level
The confidence level, 1 – α, has the following interpretation. If thousands of samples with E failures are drawn from
a population using simple random sampling and a confidence interval is calculated for each sample, the proportion
of those intervals that will include the true population parameter is 1 – α.
Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90
to 0.99 by 0.01.

Number of Events and Censoring
E (Number of Events)
Enter a value for the number of events, E. This is the number of subjects that exhibit the event of interest such as
death, cure, heart attack, failure, etc. In these types of designs, we must run the experiment long enough and with
enough subjects to achieve this many events.
You may enter a single value, a series of values, or a list of values.
The expected number of subjects, N, is given by

where C is the percent censored.

𝑁=

𝐸
1 − 𝐶/100

This calculation assumes that the experiment is run until E events occur.
Percent Censored
This is the percent of the subjects (items or objects) that are censored. These are those that have not exhibited the
event of interest by the end of the study.
Only one value may be entered.

Precision
Width of Confidence Interval (Two-Sided)
The width is the distance between the lower confidence limit (LCL) and the upper confidence limit (UCL),
calculated as UCL - LCL. The unit of measure is that of the Mean Lifetime or 𝜃, which is usually time (hours,
days, months, or years).

A reasonable width may be determined as a percentage of 𝜃. For example, suppose 𝜃 is 20 months. You might
want a sample size large enough so that you can estimate 𝜃 within plus or minus 5%, or a width of 10%. Since
10% of 𝜃 is 2 months, the width you would enter is ‘2.’

This width can be any value greater than zero. You can enter a single value, a list of values, or a series of values.
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This measure is scaled in the units of the mean survival time, 𝜃. If you want to use relative width, set 𝜃 to ‘1’ and
enter the relative width as a proportion here. For example, for 20%, you would enter ‘0.2’ here.
Distance from 𝜽 to Limit (One-Sided)
This precision measure is the distance from 𝜃 to the lower confidence limit (LCL) or the upper confidence limit
(UCL). It is calculated using | 𝜃 -LCL| or |UCL- 𝜃 |. The unit of measure is that of the Mean Lifetime, 𝜃, which is
usually time (hours, days, months, or years).

A reasonable distance may be determined as a percentage of 𝜃. For example, suppose 𝜃 is 20 months. You might
want a sample size large enough so that you can estimate 𝜃 to within 5%. Since 5% of 𝜃 is 1 month, the value you
would enter is ‘1’.
You can enter any value greater than zero. You can enter a single value, a list of values, or a series of values.

This measure is scaled in the units of the mean survival time, 𝜃. If you want to use relative distance, set 𝜃 to ‘1’
and enter the relative distance as a proportion here. For example, for 10%, you would enter ‘0.1’ here.

Planning Estimate of Mean Lifetime
𝜽 (Mean Lifetime)

𝜃 is the Mean Lifetime. It is also called the mean failure time. You should enter the value that you would expect
from a sample of this size. Note that 𝜃 is estimated by 𝑡̅.
The unit of measure used here must also be the unit of measure used for the width or distance. If you want to
make all calculation relative, enter a ‘1’ here and then proportions as widths or distances.

It is important that the value entered here is close to the actual value that will be obtained. This is accomplished
using a small pilot study or prior experience with similar subjects.
𝜃 can be any value greater than 0. You can enter a single value, a list of values, or a series of values.
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Example 1 – Calculating Sample Size
Suppose a study is planned in which the researcher wishes to construct a two-sided 95% confidence interval for 𝜃
such that the relative width of the interval is 0.05, 0.10, 0.15, and 0.20. The percent censored is anticipated to be
about 20%.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Confidence Intervals for the Exponential Lifetime Mean procedure window by expanding
Survival, then clicking on Confidence Intervals, and then clicking on Confidence Intervals for the
Exponential Lifetime Mean. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Number of Events
Interval Type ........................................... Two-Sided
Confidence Level (1 – Alpha) ................. 0.95
Percent Censored ................................... 20
Width of Confidence Interval .................. 0.05 to 0.2 by 0.05
θ (Mean Lifetime) .................................... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sided Confidence Intervals for Exponential Lifetime Mean

Number of
Confidence
Events
Level
E
0.950
6151
0.950
1541
0.950
687
0.950
388

Expected
Sample
Size
N
7689
1927
859
485

Target
Width
0.050
0.100
0.150
0.200

Actual
Width
0.050
0.100
0.150
0.200

Mean
Lifetime
𝛉
1.000
1.000
1.000
1.000

C.I.
Lower
Limit
0.975
0.952
0.929
0.908

C.I.
Upper
Limit
1.025
1.052
1.079
1.107

Report Definitions
Confidence Level is the proportion of confidence intervals (constructed with this same confidence level) that
would contain the true value of 𝛉.
Number of Events E is the number of events that must occur before the experiment can be stopped.
Expected Sample Size N is the anticipated number of subjects that must be sampled so that the desired number of
events occur.
Target Width is the width that was requested.
Actual Width is the calculated width. This is slightly different from the Target Width because E is an
integer.
Mean Lifetime 𝛉 (or mean failure time) is the total lifetime of all subjects divided by E, the
number of events.
C.I. Lower Limit and C.I. Upper Limit is the confidence interval of 𝛉.
References
Mathews, Paul. 2010. Sample Size Calculations: Practical Methods for Engineers and Scientists. Mathews Malnar
and Bailey, Inc.
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Summary Statements
A total of 6151 events produces a two-sided 95% confidence interval with a width equal to 0.050
when the estimate of 𝛉 is 1.000. The percent censoring is anticipated to be 20%. These results
assume Type-II Censoring in which the experiment is run until 6151 failures occur.

This report shows the calculated sample size for each of the scenarios.

Plots Section

This plot shows the number of events, E, for various widths.
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Example 2 – Validation using Mathews
Mathews (2010), page 192, gives an example of a sample size calculation. In this example the value of θ is 1.0,
the confidence level is 95%, and the width is 0.40 (plus or minus 0.2). The resulting number of events is 97. Note
that Mathews uses a normal approximation to the chi-square distribution which makes his results a little different
than ours.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Confidence Intervals for the Exponential Lifetime Mean procedure window by expanding
Survival, then clicking on Confidence Intervals, and then clicking on Confidence Intervals for the
Exponential Lifetime Mean. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Number of Events
Interval Type ........................................... Two-Sided
Confidence Level (1 – Alpha) ................. 0.95
Percent Censored ................................... 20
Width of Confidence Interval .................. 0.05 to 0.2 by 0.05
θ (Mean Lifetime) .................................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Number of
Confidence
Events
Level
E
0.950
100

Expected
Sample
Size
N
100

Target
Width
0.400

Actual
Width
0.399

Mean
Lifetime
𝛉
1.000

C.I.
Lower
Limit
0.830

C.I.
Upper
Limit
1.229

PASS calculates the number of events to be 100. The difference between 100 and the 97 that Mathews obtained is
because Mathews used a normal approximation to the chi-square distribution. PASS used exact chi-square results.
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